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The objective of this master’s thesis was to create a CAD library for printed passive components. 
An electronic system consists of electronic components. Designing an electronic system with CAD 
software starts with selecting electronic components, which are the elements in a CAD library. 
Traditional electronics have good support from CAD software, and its electronic component librar-
ies have rich content. Printed electronics are a new research and engineering area. However, CAD 
libraries for printed electronics lack content. Designing electronic systems with printed electronic 
components, but without support from the CAD libraries has a big challenge. The aim of this thesis 
is to try to find a solution by creating a CAD library for printed passive components.  
 
Theoretical research and tool selection are necessary prerequisites for creating a CAD library. First, 
this thesis introduces the meaning of electronic components and the difference between active and 
passive components. The working principle of passive electronic components are described, espe-
cially resistors, capacitors, and inductors. Then scientific publications are summarized to find man-
ufacturing methods, materials, and equipment for the printed passive components. During the lit-
erature research, important geometrical and electrical parameters for creating CAD libraries are 
recorded. After all theoretical studies, the software tools which are used for creating CAD libraries 
are selected. Their features and application areas are discussed and compared in a wide range.  
 
As the kernel of the thesis, a process for creating library components is described. It demonstrated 
step by step to create a resistor in KiCAD and a capacitor in Altium Designer. Fusion 360 is used 
to create the components’ 3D model. The processes in this three software represent the process 
of creating a CAD library for printed passive components. By using the same process with different 
electronic components’ parameters, the library’s content can be extended. In the end, as verifica-
tion, a simple RLC circuit was demonstrated by using a newly created CAD library. 
 
This work shows a solution to create a CAD library for printed passive components. However, Sci-
entific research and engineering development are still ongoing. New printed electronic components 
appear every year. Libraries need to be maintained as the number of components increases. This 
could be the research and engineering area for the future.  
 
 
 
 
 

Keywords: printed electronic, CAD, Altium Design, KiCad, Fusion 360, Passive Electronic Compo-
nents   



  

4 

1.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



  

5 

Contents 

1 Introduction .......................................................................................................................... 12 

2 Electronic Passive Component ............................................................................................ 13 

2.1 Resistor .................................................................................................................... 14 

2.2 Capacitor .................................................................................................................. 14 

2.3 Inductor .................................................................................................................... 15 

2.4 Passive Transducers ................................................................................................ 17 

3 Fabrication for Printed Passive Components ....................................................................... 18 

3.1 Overview of Printing Technologies ........................................................................... 18 

3.2 Materials Used for Printed Passive Components ..................................................... 19 

3.2.1 Conductive Materials ................................................................................. 20 

3.2.2 Dielectric Materials ..................................................................................... 21 

3.3 Fabrication of Printed Resistor ................................................................................. 21 

3.4 Fabrication of Capacitor ........................................................................................... 22 

3.5 Fabrication of Inductor .............................................................................................. 24 

3.5.1 Meander Inductor ....................................................................................... 25 

3.5.2 Square Inductor ......................................................................................... 26 

3.5.3 Circular Inductor ......................................................................................... 27 

3.5.4 Octagonal Inductor ..................................................................................... 27 

4 CAD Software for Electronic Modelling ................................................................................ 29 

4.1 ECAD Modeling Program ......................................................................................... 30 

4.1.1 Altium Designer .......................................................................................... 30 

4.1.2 KiCad ......................................................................................................... 33 

4.1.3 Different Between Altium Designer and KiCad. .......................................... 34 

4.2 Fusion 360 & Autodesk Eagle .................................................................................. 35 

4.3 ECAD Library & Workflow ........................................................................................ 36 

5 Library and Application with PE Components ...................................................................... 39 

5.1 PE Resistor with KiCad ............................................................................................ 39 

5.1.1 New Project and Library Category ............................................................. 39 

5.1.2 New Footprint ............................................................................................. 41 

5.1.3 3D Modelling PE Resistor .......................................................................... 43 

5.1.4 Connecting Electronic Symbol with a Footprint .......................................... 47 



  

6 

5.2 Capacitor Library in Altium Designer ........................................................................ 47 

5.2.1 Schematic Symbols ................................................................................... 48 

5.2.2 Footprint ..................................................................................................... 49 

5.2.3 Creating a 3D Body for PE Capacitor......................................................... 51 

5.2.4 Footprint for Schematic Symbol ................................................................. 52 

5.3 Application of PE library ........................................................................................... 53 

5.3.1 Project Structure and New Project ............................................................. 53 

5.3.2 Import Existing Libraries............................................................................. 54 

5.3.3 Creating Schematic Plan............................................................................ 55 

5.3.4 Layout of Printed Circuit ............................................................................. 57 

6 Discussion and Conclusion .................................................................................................. 60 

7 References .......................................................................................................................... 61 

8 Appendices .......................................................................................................................... 65 

 

 

 



  

7 

List of Abbreviations 

Abbreviations 

AC Alternating Current 

CAD Computer-Aided Design 

CAM Computer-Aided Manufacturing 

DC Direct Current 

ECAD Electronic computer-aided design 

EDA Electronic Design Automation 

EMF Electromotive Force 

ERC Electronic rule check 

LIFT Laser-Induced Forward Transfer 

MCAD Mechanical computer-aided design 

PE Printed Electronics 

PLM Product lifecycle management 

 

Symbols  

R Resistance 

A Cross-Sectional Area of the Conductor 

C Capacitance 

d Distance Between the Two Plates 

L Inductance 

n Number of Turns 

r Radius of Coil 

s Length of Turns 

ε Electric Constant 

𝑙 Length of the Conductor 

𝜌 Electrical Resistivity of The Material 

 

 



  

8 

List of Tables 

Table 1 Passive components, symbols & 3D Models in KiCAD (Suite, 2021) .............................. 13 

Table 2 Different Printing Technologies (Kipphan, 2001) (Tan, et al., 2016) (Panreck, et al., 2018) 

(Pohl, et al., 2015) ........................................................................................................................ 18 

Table 3 Characteristics of Printing Technologies (Kipphan, 2001) (Panreck, et al., 2018) (Kwon, et 

al., 2020) ...................................................................................................................................... 19 

 



  

9 

List of Figures  

Figure 2-1 Generalized diagram of a capacitor (Hughes, 2015) .................................................. 15 

Figure 2-2 Current, voltage, and inductance (Sinclair, 2000) ....................................................... 16 

Figure 2-3 Inductors with single-layer air core coil (Sinclair, 2000) .............................................. 16 

Figure 2-4 Different types of inductors (McLyman, 2017) ............................................................ 17 

Figure 3-1 Schematic representation of printed resistor (Correia, et al., 2018) ............................ 22 

Figure 3-2 Resistance of inkjet-printed resistor (Correia, et al., 2018) ......................................... 22 

Figure 3-3 Different types of capacitors a) Interdigital capacitor (Blecha, et al., 2017), b) Sandwich 

capacitor (Correia, et al., 2018).................................................................................................... 23 

Figure 3-4 Dimensions and geometry of interdigital capacitor (Blecha, et al., 2017) ................... 23 

Figure 3-5 Dimensions and geometry of Sandwich capacitor a) Single stack capacitor, b) Triple 

stack capacitor (Correia, et al., 2018) .......................................................................................... 24 

Figure 3-6 Planar inductor structures for silicon-based electronic (Haobijam, et al., 2014) .......... 24 

Figure 3-7 Printed inductor: (a) meander inductor (Menicanin, et al., 2015) (Menicanin, et al., 2013), 

(b) square inductor (Correia, et al., 2018), (c) Circular inductor (Ostfeld, et al., 2015), (d) octagonal 

inductor (Menicanin, et al., 2015). ................................................................................................ 25 

Figure 3-8 Meander inductor a) geometric model (Menicanin, et al., 2013), b) inkjet printed meander 

inductor one turn (Menicanin, et al., 2015), c) inkjet-printed meander inductor three turns 

(Menicanin, et al., 2015) .............................................................................................................. 26 

Figure 3-9 Geometric parameters and inductance (Ostfeld, et al., 2015) .................................... 27 

Figure 3-10 Geometrical structure and parameters of an octagonal inductor (Menicanin, et al., 

2015) ............................................................................................................................................ 28 

Figure 4-1 Electronic schematic with Visio (DMExplains, 2016) .................................................. 29 

Figure 4-2 CAD in product development (Mafukidze, 2022) ........................................................ 30 

Figure 4-3 Altium designer 22 user interfaces (Designer, 2021) .................................................. 31 

Figure 4-4 Hierarchical design in Altium design (Altium, 2022) .................................................... 31 

Figure 4-5 ECAD-MCAD Codesign in Altium designer (Altium, 2021) ......................................... 33 

Figure 4-6 KiCad Project manager window .................................................................................. 33 

Figure 4-7 Fusion 360 interface (Autodesk, 2022) ....................................................................... 35 

Figure 4-8 Components panel in Altium Designer ........................................................................ 37 

Figure 4-9 Library panel in KiCad ................................................................................................ 37 

Figure 4-10 PCB design workflow (Dalmaris, 2019) .................................................................... 38 



  

10 

Figure 5-1 Creating a new KiCad Project ..................................................................................... 39 

Figure 5-2 A new KiCad project ................................................................................................... 40 

Figure 5-3 Footprint editor symbol ............................................................................................... 40 

Figure 5-4 Footprint editor ........................................................................................................... 40 

Figure 5-5 Creating a new footprint library ................................................................................... 41 

Figure 5-6 A new library for PE components................................................................................ 41 

Figure 5-7 New footprint symbol .................................................................................................. 42 

Figure 5-8 Pad properties ............................................................................................................ 42 

Figure 5-9 Footprints of a PE resistor .......................................................................................... 43 

Figure 5-10 Footprints of a PE resistor in 3D view ....................................................................... 43 

Figure 5-11 Sketch tools and PE resistor dimensions .................................................................. 44 

Figure 5-12 Extrude in Fusion 360 ............................................................................................... 44 

Figure 5-13 Export 3D model ....................................................................................................... 45 

Figure 5-14 Import 3D Model in KiCad ......................................................................................... 46 

Figure 5-15 3D Model preview ..................................................................................................... 46 

Figure 5-16 Symbol properties and footprint ................................................................................ 47 

Figure 5-17 Crating the new Altium Designer library .................................................................... 48 

Figure 5-18 Libraries for schematic symbols................................................................................ 48 

Figure 5-19 Tools for drawing the symbols .................................................................................. 49 

Figure 5-20 Capacitor symbol ...................................................................................................... 49 

Figure 5-21 Creating a PCB Library ............................................................................................. 50 

Figure 5-22 Pad properties .......................................................................................................... 50 

Figure 5-23 3D Body for footprint ................................................................................................. 51 

Figure 5-24 PE Capacitor footprint 2D (left) and 3D (right) layout ................................................ 51 

Figure 5-25 Dimensions of PE capacitor (left) and 3D Model (right) ............................................ 52 

Figure 5-26 Footprints for schematic symbol ............................................................................... 52 

Figure 5-27 New Altium Designer Project .................................................................................... 54 

Figure 5-28 Libraries with PE components .................................................................................. 54 

Figure 5-29 Libraries outside (left) and inside (right) the Project .................................................. 55 

Figure 5-30 New schematic and PCB documents ........................................................................ 55 

Figure 5-31 RLC circuit before annotation ................................................................................... 56 

Figure 5-32 Annotate schematics ................................................................................................ 56 

Figure 5-33 RLC circuit schematic plan ....................................................................................... 56 

Figure 5-34 Update PCB Document ............................................................................................ 57 



  

11 

Figure 5-35 2D (left) and 3D(right) layout from schematic plan .................................................... 58 

Figure 5-36 Render image of printed RLC circuit on transparent film front (left) and back view (right)

 ..................................................................................................................................................... 58 

Figure 5-37 Elements of CAD Library and applied software tools ................................................ 59 

 



  

12 

1 Introduction  

Electronic technology has been one of the fastest-growing technologies in the last two centuries. It 

transformed and made our lives better in a different way. In the 19th century, the electric stove (in 

1859 by George B. Simpson), the light bulb (in 1879 by Thomas Alva Edison) was invented, and in 

1985 the wireless telegraph and the radio communication became true. (casx123, 2021) Entering 

the 20th century, new inventions were not only new materials, various functions but also diameter. 

During this technological singularity diode (1904), triode (1907), the transistor radio (1954), inte-

grated circuit (1958-1959), and the computer on a chip (1971) were discovered or invented 

(Constable, et al., 2003). Just when people were about to enter the 21st century, in 1998, a plastic 

transistor was developed (Constable, et al., 2003). This material opened a gate for printed elec-

tronics. With this new material, electrical components can be flexible and produced like the news-

paper. The unique manufacturing process for electronics increased productivity and reduced the 

price per unit. Many new materials, technologies, and applications have been discovered in the last 

years. (Holden, 2020) Scientists, engineers, and people with different backgrounds have been in-

vesting with high enthusiasm in printed electronics. A lot of investigation was put into printed elec-

tronics, and many other applications were developed in the laboratory. But there is still a lot to be 

done to transfer the success of scientific research to large-scale industrial production.  

 

The design of electrical devices was started from scratch on paper and draft schematics. The dif-

ferent computer programs are used today by electrical engineers thanks to computer technology. 

With the help of computer-aided design (CAD), tasks can be done in a more accessible manner 

than before on paper. Complicated electrical equipment can be constructed and even simulated in 

a virtual environment; a possible failure could be detected before the prototype. Product improve-

ment and iteration could be accelerated. As a result, a lot of time and funds could be saved, better 

product quality could be more accessible, and complicated systems could be invented, which were 

unimaginable without CAD.  

 

Electrical equipment consists of electronic components. Electronic components are included in the 

famous CAD/CAM (computer-aided manufacturing) tools as databases. This makes design and 

collaborative work very efficient. However, the recently appeared printed electrical components 

were rarely seen in the database. The work in this thesis attempts to introduce tools and processes 

to create CAD library for printed electronic components.  
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2 Electronic Passive Component 

An electronic component is an essential part of electrical equipment. It helps the functioning of 

electrical equipment. Different electronic components can be classified into active and passive 

components (Sinclair, 2000) (Hughes, 2015). Active components can amplify the signal by using 

external energy, for instance, a power supply. Signals that pass through a passive part will become 

weaker. The passive component causes the loss of energy (Sinclair, 2000).  

 

Passive components are the resistor, capacitor, inductor, and transducer. External power sources 

are not required for the operation of passive components. Power or energy from the circuit is em-

ployed and transformed by passive components in the form of voltage or current, and power gain 

can be produced. The flow of the current cannot be controlled. They act as energy receptors in an 

electrical system. (Hughes, 2015) (Dif21)  

 

Table 1 presents different symbols and 3D models used in the library of electronic design automa-

tion (EDA) software KiCad.  

 

Table 1 Passive components, symbols & 3D Models in KiCAD (Suite, 2021) 

components Symbols 3D Models 

Resistor 
 

 

Capacitor 

 
 

Inductor 
 

 

Transducer 

(Sensor 

PT100) 
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2.1 Resistor 

Passive components have different electronic properties and are used in various applications. 

When current flows through the resistor, part of the electricity is converted into heat and dissipated 

to the surrounding area. Current flowing through the resistor is proportional to the applied voltage. 

An ideal resistor has the same impedance performance at all signal frequencies from direct current 

(DC) to alternating current (AC); it follows Ohm’s law (Sinclair, 2000). Resistors can limit the current 

in electronic circuits and can also be found in most heating equipment. (ETechnoG, 2021) 

 

Two factors influence the resistor of a given object. Equation (1-1) describes this relationship. 𝜌 is 

related to the type of materials. Resistance is positively correlated to the length, and the larger 

cross-section has lower resistance.  

 𝑅 =  𝜌
𝑙

𝐴
  (1-1)  

 

R: Resistance, Ω 

𝜌: Electrical resistivity of the material (Ω·m) 

𝑙: Length of the conductor, (m) 

A: Cross-sectional area of the conductor, (m²) 

2.2 Capacitor 

The working principle of the capacitor is explained with simplified graphics in Figure 2-1. There is 

a dielectric located between two conductive plates, which can be for example metal. The energy is 

stored in an electrostatic field; a potential between the two plates generates this. The capacitance 

between two plates can be calculated with the equation (1-2) (Bird, 2010). 
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Figure 2-1 Generalized diagram of a capacitor (Hughes, 2015) 

 

 𝐶 = 𝜀
𝐴

𝑑
 (1-2) 

 

C: Capacitance, Farads 

A: Direct facing area of the two plates, square Meters 

ε: Electric constant 

d: Distance between the two plates, Meters 

 

Based on its unique structure (Figure 2-1), DC cannot pass through a capacitor. However, AC, 

whose direction is reversed periodically, could pass through it. Capacitors are often used to let a 

signal of a particular frequency pass.  

2.3 Inductor 

Besides resistors and capacitors, inductors make up other critical passive components. In 1831 

Michael Faraday discovered a phenomenon, an electromotive force (EMF, voltage) which could be 

generated in a time-varying magnetic field located conductor. The inductor is an application of 

electromagnetic induction on the coil. (Sinclair, 2000) Unlike the capacitor, an inductor has the 

opposite behavior, and it allows DC to pass but impedes AC.  

 

The unit of inductance is Henry. It represents the current change rate of 1 ampere/second and 

induces a voltage of one volt (Figure 2-2). (Sinclair, 2000)  
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Figure 2-2 Current, voltage, and inductance (Sinclair, 2000)  

For a single-layer air-core coil (Figure 2-3), an approximate inductance can be calculated with for-

mula in (1-3) (Sinclair, 2000) 

 

Figure 2-3 Inductors with single-layer air core coil (Sinclair, 2000) 

 𝐿 =
2.8𝑟2𝑛2

𝑟 + 1.11𝑠
 (1-3) 

L: Inductance, µH 

r: Radius of coil, cm 

s: Length of turns, cm 

n: Number of turns 

 

The magnetic material can be used in the inductor’s core in many applications. This can increase 

inductance enormously. Inductors also have different shapes of construction. In the traditional and 

silicon-based electronic applications, inductors are primarily in 3 dimensions. Figure 2-4 shows the 

different variants.  
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Figure 2-4 Different types of inductors (McLyman, 2017) 

2.4 Passive Transducers 

The previous chapter describes energy conversion from electrical energy into heat by a resistor, 

electric field by a capacitor, and magnetic field by an inductor. Passive transducers reverse this 

process. It transforms between physical quantities. For instance, heat and displacement could be 

converted into variable resistance, capacitor, or magnetic resistance. Some real applications are 

thermocouples, capacitor microphones, capacitor touch sensors, or moving iron microphones. 
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3 Fabrication for Printed Passive Components 

Traditional passive components are presented in chapter 2. The difference in function and principle 

between the printed passive components and the conventional passive components is limited, 

whereas printed components’ fabrication is unique. Printed electronics (PE) is manufactured with 

printing technology and implements a particular printing material with an electronic function. This 

chapter summarizes different printing technologies used for PE fabrication and how the printed 

passive components are developed by utilizing printing technologies.  

3.1 Overview of Printing Technologies 

Printing is defined as a reproduction process by applying the printing ink to a substrate with the 

help of an image-carrying medium. (Kipphan, 2001) Divided by the image-carrying medium, printing 

technologies can be categorized into contact and non-contact printing. The technologies applied in 

graphic printing and printed electronics are similar, but they have different quality requirements. 

Graphic printing is concentrated on optical quality, and electronic properties are important in printed 

electronics. The commonly used printing technologies are presented in Table 2. Most of them are 

used by graphic printing and printed electronics, but Aerosol jet and dispensing printing are more 

common in printed electronics. These two technologies use a single nozzle to generate dots, lines, 

and surfaces on two dimensions. It also has the capability of printing three-dimensional compo-

nents.   

 

Table 2 Different Printing Technologies (Kipphan, 2001) (Tan, et al., 2016) (Panreck, et al., 2018) 
(Pohl, et al., 2015) 

Contact printing technologies Non-contact printing technologies 

• Screen Printing 

• Gravure printing 

• Flexographic printing  

• Offset lithography 

• Aerosol jet printing  

• Inkjet printing 

• Dispensing printing 

• Laser-induced forward trans-

fer (LIFT) 
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Depending on the application, different printing technologies have their advantages and disad-

vantages. They have their unique adaptability related to the substrate and ink. For instance, screen 

printing utilizes high viscosity ink and can have very high layer thickness. It also has good substrate 

adaptability. This could benefit the production conductor, which requires higher power transfer on 

the substrate. In opposite, inkjet ink has very low viscosity, but it has a very thin layer thickness. It 

does not need a printing plate; files can be directly printed on the substrate. Table 3 presents the 

critical feature of different printing technologies.  

 

Table 3 Characteristics of Printing Technologies (Kipphan, 2001) (Panreck, et al., 2018) (Kwon, et 

al., 2020) 

 Printing plate Ink viscosity (cP) Line width (µm) Layer thickness (µm) 

Screen with 1000 – 50,000 30 – 50 Up to 12 

Gravure  with 50 – 200 10 – 50 0.8 – 8 

Flexographic with 50 – 500 45 – 100 0.8 – 2.5 

offset with 40,000 – 100,000 ~ 10 0.5 – 1.5 

aerosol without  1 – 1000 PA ~ 10 0.1 – 2 

inkjet without 5 – 20 30 – 50 < 0.5 

dispensing without 1 – 1,000,000 5 – 200 -    

 

3.2 Materials Used for Printed Passive Components 

Substrate and ink are indispensable and important materials for producing printed electronics. Dif-

ferent substrates are found in the research and applications. Substrates from different materials 

have separate properties. For instance, paper (Santhiago, et al., 2017) (Siegel, et al., 2010) or 

fabrics (Simegnaw, et al., 2021) (Wei, et al., 2013) are porous, in which the substrate could absorb 

the ink; on the other hand, ink sticks only on the surface of the metal, glass (Hrehorova, et al., 

2011) and plastics. Polymer materials raise broad interest in PE applications thanks to their excel-

lent environment reliability and flexible characteristics. Passive components could be produced on 

different polymer substrates, such as polyimide (PI), polyetherimide (PEI) (Salmerón, et al., 2014), 

polyethylene naphthalene (PEN) (Correia, et al., 2018), and polyethylene terephthalate (PET) 

(Ostfeld, et al., 2015). Some polymer Substrates are commonly used materials in our daily lives. 
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For example, PET is a widely used low-cost, food-safe material in producing drink bottles. With the 

benefit of lower material prices, the advantages of PE products are becoming more prominent. 

 

There are various kinds of function ink materials used for PE components. According to the different 

classification methods PE materials could be organic or inorganic. (Cui, 2016) Furthermore, they 

can be divided into conductors, dielectrics, and semiconductors. Conductors and dielectrics are 

commonly used materials for the fabrication of passive components.  

3.2.1 Conductive Materials  

Organic conductive materials are reported in the recent application. For instance, polyacetylene, 

polyaniline, polypyrrole, polythiophene, and poly(3,4-ethylene dioxythiophene) (PEDOT) are the 

most researched conductive polymer. (Wang, et al., 2019) (Liu, et al., 2003) By applying the doping 

process, the conduction of polyacetylene is almost comparable to copper. (Cui, 2016) Conductive 

materials can also be obtained by dispersion of many conductive materials, for example, metal 

powder or graphene in a non-conductive polymer. (Hardin, et al., 2019) 

 

Commonly used inorganic materials are a mix of metal particles within resins to produce printed 

pastes, and the “paste” can be used for screen printing. Resin-containing paste has a higher post-

treatment temperature, and the resistivity (1,000 to 100 µΩ∙cm) is 2 to 3 orders higher than bulk 

metal (1 µΩ∙cm). (Cui, 2016) Recently developed nanotechnology has enabled the dispersion of 

nanosized metal particles in solvents. With the help of surfactants, nanoparticle ink could be treated 

at a lower temperature, but its conductivity is much better than the “paste”; it is only a few times 

lower than the bulk material. (Anto, et al., 2010) 

 

Because of its high conductivity, silver (Ag) 1.59 µΩ∙cm, copper (Cu) 1.72 µΩ∙cm, gold (Au) 2.44 

µΩ∙cm, and aluminum (Al) 2.65 µΩ∙cm are mainly used as materials to produce inorganic con-

ductive materials. Au has the best environmental stability, but it is the most expensive material 

compared to the other materials. Cu and Al have poor ecological stability. They both have a high 

tendency for oxidation. For this reason, Cu and Al nanoparticle ink are challenging to prepare. Ag 

becomes the most cost-effective nanoparticle ink to produce the conductive layer. (Cui, 2016) 
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Conductive ink can also be obtained by heavily doping a transparent oxide semiconductor to obtain 

transparent conductive oxide (TCO). This material has much lower conductivity than nanoparticle 

ink, but it has its unique transparent property; for example, a TFT panel needs transparent wires.  

 

3.2.2 Dielectric Materials 

Dielectric or insulating materials are the critical material in producing multi-layer electrical compo-

nents. It prevents electrical leakage between different layers (for example, conductors or semicon-

ductors) and makes the production of multi-layer capacitors possible. The dielectric layer must be 

thick enough to prevent electronic leakage. In some cases, it needs to be thinner to get better 

overall performance, for example, a large capacitor. (Hardin, et al., 2019) 

 

The insulating materials can be organic or inorganic. Printable organic dielectric materials include 

poly(methyl methacrylate) [PMMA] (Hardin, et al., 2019), polyimide [PI] (Zhang, et al., 2016), 

poly(vinyl phenol) [PVP], poly(vinyl alcohol) [PVA], polystyrene [PS], poly(perfluorobutenylvi-

nylether) [CYTOP] and benzocyclobutene [BCB] (Cui, 2016). Inorganic inks include inorganic ox-

ides (ALOx, ZrOx, HfOx, TiOx), (Caironi, et al., 2015) ion-gel and solid-state electrolytes (SiO2) (Cui, 

2016). 

 

Organic dielectric materials have the advantages of materials variety, surface roughness, surface 

trap density, compatibility with other organic materials, cost, flexibility, and low temperature. (Cui, 

2016) because of these properties, it has a good potential to produce flexible electronics. Inorganic 

materials have better properties at high permittivity and high-frequency stability. But it requires high-

quality film formation and a high-temperature post-process. (Cui, 2016) (Caironi, et al., 2015)  

3.3 Fabrication of Printed Resistor  

Correia (Correia, et al., 2018) reported in his publication on an inkjet-printed resistor. Teonex 

Q65HA poly (ethylene naphthalate) PEN film was used as a substrate. The electrode layer was 

printed with nanoparticle Ag ink (UT DOTs inc.). Conductive polymeric ink Poly(3,4-ethylene diox-

ythiophene) poly(styrene sulfonate) PEDOT:PSS was used as an active layer. The ink was printed 

with Fujifilm DMP-3000 with the DMC-11610 cartridge and 10 pL drop volume. Ag layer was printed 
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as the first layer, then the PEDOT:PSS was printed after, and different layers were printed without 

curing in between. Ag ink was dried in the oven for 30 minutes at 150 °C, and PEDOT:PSS was 

cured at 130 °C for 5 minutes. 

 

 

Figure 3-1 Schematic representation of printed resistor (Correia, et al., 2018) 

The inkjet-printed resistors had 500 µm in width, 0.5 mm to 2 mm in length, and were printed in 2, 

4, and 6 layers. After the dry and curing, the resistance was between 25 Ohm to 650 Ohm (Figure 

3-2) with less than 5% tolerance. 

 

Figure 3-2 Resistance of inkjet-printed resistor (Correia, et al., 2018) 

3.4 Fabrication of Capacitor 

The printed capacitor can be produced differently. Interdigital capacitors and sandwich capacitors 

are the general constructions of printed capacitors (Blecha, et al., 2017). The interdigital capacitor 

(Figure 3-3 left) has only two dimensions and needs only conductive ink. The ink is printed on the 

dielectric substrate with the unique geometric shape of the electrode, and the two electrodes are 

very close, so a capacitor can be generated. A sandwich capacitor is printed layer by layer. The 

dielectric layers between each conductive layers are printed (Figure 3-3 right). 
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a) b) 

Figure 3-3 Different types of capacitors a) Interdigital capacitor (Blecha, et al., 2017), b) Sandwich 
capacitor (Correia, et al., 2018) 

Blecha (Blecha, et al., 2017) presented in his report an interdigital capacitor. It was produced with 

screen printing technology. The silver paste DuPont 5029 was printed on PET film. The capacitor 

had the dimensions (Figure 3-4) of w = s = 0.75 mm, l = 20 mm, and interdigital pairs = 20.  

 

Figure 3-4 Dimensions and geometry of interdigital capacitor (Blecha, et al., 2017) 

The sandwich capacitor was found in Correia’s report (Correia, et al., 2018). The dielectric layer 

was printed with cross-linked poly (4-vinylphenol), with propylene glycol monomethyl ether acetate 

(PGMEA) and poly (melamineco-formaldehyde (PMFM) (C-PVP). The material used for the sub-

strate and electrode was the same as described in chapter 3.3. The capacitors were produced with 

an active area of 5 x 5 mm² and 2.5 x 2.5 mm². The dielectric layer was slightly bigger with the 5.5 

x 5.5 mm² and 3 x 3 mm² to guarantee good isolation. All the layers were printed with inkjet tech-

nology. The print head has a typical drop volume of 10 pL. The printer was set on 40 µm drop 

space for the conductive layer and 15 µm drop space for dielectric layers. Single stack and triple 

stack capacitors were printed with the same process. The geometry of the sandwich capacitor is 

presented in Figure 3-5. Both conductive and dielectric layers were cured layer by layer in the oven 

(Nabertherm TR240) at 150°C and 30 minutes.  
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a) b) 

Figure 3-5 Dimensions and geometry of Sandwich capacitor a) Single stack capacitor, b) Triple 
stack capacitor (Correia, et al., 2018) 

The capacitance was 2.0 nF/cm² for the single stack and 3.2 nF/cm² for the triple stack. (Correia, 

et al., 2018) 

3.5 Fabrication of Inductor 

Printed inductors are mainly planar spiral inductors due to the property of printing technologies. 

Generally, only one printed layer is required. In some cases, the dielectric layer is printed to avoid 

the shortcut [22] between the electrodes or protect the printed layer (Pajkanovic, et al., 2016). Pla-

nar spiral inductor used in silicon-based electronic and printed electronics has similar structures. 

Figure 3-6 shows the commonly used planar inductor structures for silicon-based electronics. Fig-

ure 3-7 presents the printed product of planar inductor structures from a different source.  

 

 

Figure 3-6 Planar inductor structures for silicon-based electronic (Haobijam, et al., 2014) 
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a) 

 

b) 

 

c) 

 

d) 

Figure 3-7 Printed inductor: (a) meander inductor (Menicanin, et al., 2015) (Menicanin, et al., 
2013), (b) square inductor (Correia, et al., 2018), (c) Circular inductor (Ostfeld, et al., 2015), (d) 

octagonal inductor (Menicanin, et al., 2015). 

3.5.1 Meander Inductor 

Menicanin presented an inkjet-printed meander inductor (Menicanin, et al., 2015). In her articles, 

PET film (Novele IJ-220) with a thickness of 140 µm from the company Novacentrix was used as 

substrate. Water-based Nanoparticle silver ink Metalon® JS-B25HV (25% wt of silver) was printed 

as a conductive layer. Printing equipment was DMP3000 from Fujifilm. The printer was adjusted 

with 25 µm drop space, and the drop volume was 1 pL. 
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a) 

  

b)  

   

c) 

Figure 3-8 Meander inductor a) geometric model (Menicanin, et al., 2013), b) inkjet printed mean-
der inductor one turn (Menicanin, et al., 2015), c) inkjet-printed meander inductor three turns 

(Menicanin, et al., 2015) 

Two different meanders were printed with one and three turns.  Its geometric model and actual 

product are presented in Figure 3-8. The width of the conductive line and the spacing between 

them were the same w = s = 200 µm. Inner dimension dx was 1.8 mm for one turn and 3.4 mm for 

three turns. Inner dimension dy was the same 2.0 mm for both 1 and 3 turns. A ring-shaped ground 

plane of 400 µm width was surrounding the inductor. Post-treatment was implemented with an 

oven at 110°C for 40 minutes. The average layer thickness of printed layers was approximately 

800 nm.  

3.5.2 Square Inductor 

The inkjet-printed square inductor was found in Correia’s article (Correia, et al., 2018). PEN film 

Teonex Q65HA was used as substrate. UT DOTs nanoparticle Silver ink (UTDAgIJ1) was used for 

printing the conductive layer. Dielectric material C-PVP was printed for isolation between two elec-

trodes. Inkjet printer Fujifilm Dimatrix DMP3000 with 10 pL drop volume cartridge was used. Drop 

space was adjusted with 40 µm for the conductive layer and 15 µm for the dielectric layer. The 

square inductor was printed with 100 µm line width, 75 µm line spacing, and 25 turns. After printing, 

the substrate was sintered in the oven at a temperature of 150°C for 30 minutes. The square in-

ductor was measured, and its inductor was 5.42 µH ± 13%.  

 



  

27 

 

 

 

3.5.3 Circular Inductor 

Screen printed circular inductor was introduced by Ostfeld (Ostfeld, et al., 2015). Dupont 5028 

silver micro flake ink was printed on PET substrate with Asys ASP01M screen-printer. The screen 

was made from stainless steel with 400 threads per inch mesh size. The printing parameter was 

adjusted at 60 mm/s printing speed, 55 N squeegee force, and 1.5 mm snap-off distance. The 

printed substrate was sintered in an oven at 140°C for 10 minutes. The geometric parameters and 

the inductance were described in Figure 3-7 c) and Figure 3-9. 

 

Figure 3-9 Geometric parameters and inductance (Ostfeld, et al., 2015) 

3.5.4 Octagonal Inductor 

An inkjet-printed octagonal inductor was reported in Menicanin’s article (Menicanin, et al., 2015). 

Water-based silver ink (Metalon® JS-B25HV) was printed with the inkjet printer Fujifilm Dimatrix 

DMP3000 on PET substrate Novele IJ-220. The 1 pL drop volume cartridge was used, and the 

drop spacing was adjusted to 25 µm. After the printing, the substrate was sintered in an oven at 

100°C for 40 minutes. The geometrical structure and parameters are presented in Figure 3-10. 

This octagonal inductor had an inductance of 20 nH.  
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Figure 3-10 Geometrical structure and parameters of an octagonal inductor (Menicanin, et al., 
2015) 
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4 CAD Software for Electronic Modelling 

Electronic computer-aided design (ECAD) is a software tool. It is used to help engineers and de-

signers plan electronic systems, for instance printed circuit boards (PCB). ECAD and electronic 

design automation (EDA) point to the same software (Team, 2020). Before the ECAD software was 

introduced, designing, and planning of an electronic system was done on paper. Today a simple 

drawing and diagram software can do the same task as it was done on the paper. Microsoft Visio 

is a diagramming and vector graphic software. With the help of electrical engineering templates, 

Visio can be used for creating electronic schematics (Walker, 2007). Visio has a similar user inter-

face as other Microsoft office software. Figure 4-1 shows the user interface in Visio. Electronic 

symbols can be found in electrical engineering templates. A third-party symbol database (Visio 

shapes stencils) could also be imported to Visio (Herber, 2021). But Visio does not have the func-

tion included in the modern ECAD program. The popular computer-aided design (CAD) and EDA 

software not only can draw a schematic plan but also has an automatic processing function that 

can help design and plan the layout of the printed circuit. 

 

 

Figure 4-1 Electronic schematic with Visio (DMExplains, 2016) 

ECAD software is used to create electronic systems. Mechanical computer-aided design (MCAD) 

is used to design mechanical systems. ECAD and MCAD software are used together to create 

products in real situations. A smartphone can be a good example. It is a piece of electrical equip-

ment but has mechanical parts; all the electrical components are placed in an enclosure. Both 
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ECAD and MCAD are used for developing a smartphone. Figure 4-2 illustrates a simplified life cycle 

in electronic product development. ECAD and MCAD are both important in designing the product.  

 

Figure 4-2 CAD in product development (Mafukidze, 2022) 

Different ECAD tools are available. A comparison can be found in the literature 

(softwareradius.com). Depending on the application area, they all have advantages and disad-

vantages. For example, they may have different features, usability, system complexity, technical 

support, operation system compatibility, price, etc.  

 

The PCB design workflow is similar in different ECAD software. In the first step, electrical symbols 

are placed on the schematic plan. The electrical symbols are a part of the software library, or they 

could be created according to an individual requirement. At this stage, footprints may also be con-

nected with the related symbols when the schematic plan is complete without failure. The next step 

is, translate the schematic plan into a PCB layout. In this step, footprints are placed on the circuit 

board, and conductive tracks are placed between components. After this step, the board layout 

should be ready, and a PCB fabricator can fabricate it. (Keeth, et al.) 

4.1 ECAD Modeling Program 

4.1.1 Altium Designer 

Altium Designer is an ECAD software for printed circuit board design (Designer, 2021). It has been 

in the market for nearly 20 years and considered to be one of the best PCB design programs in the 

industry (softwareradius.com). It is the most widely used ECAD application for PCB design. Figure 

4-3 shows the Altium designer’s working environment.  
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Figure 4-3 Altium designer 22 user interfaces (Designer, 2021) 

Some features of this software are described below: 

Hierarchical Schematic design is helpful for big projects with many designs and pages included. 

Each schematic design can be nested or connected with its parent or child design. The CAD soft-

ware considers the logical relations between each design (Systems). Figure 4-4 shows the over-

view of hierarchical design in Altium design.  

 

 

Figure 4-4 Hierarchical design in Altium design (Altium, 2022) 
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Schematic driver design rules and product lifecycle management (PLM): The design of an 

electronic system starts with schematic planning. Altium’s electronic rule check (ERC) can be ap-

plied at the very beginning of the electronic system design or any step of the PLM. It can help find 

and eliminate mistakes in the schematic by checking the utilized rules. With the help of this tool, 

the designer can concentrate on the design and not spend too much time checking the failure in 

the design. (Carlson, 2020) (Keller, 2016) 

 

Extensive library and components: Altium Design contains over 400,000 components in its li-

brary (softwareradius.com), it can be maintained separately, and its content is extendable. There 

are three ways to maintain the library. Workspace Library, Database Libraries, and File-based Li-

braries. The Workspace library maintains the components in your registered account on Altium 

Designer Workspace, which is a cloud-based infrastructure platform. The library can be saved in 

the company database. In this way, the Database Libraries are utilized. The file-based Libraries 

hold the components locally on the computer as files. (Altium, 2021) Library components can be 

imported from existing files and created from scratch with your unique design.  

 

Advanced 3D visualization and ECAD-MCAD integration: Altium Designer supports a 3D PCB 

editor. When the schematic design is translated to PCB, the 3D view of PCB can be presented in 

Altium Designer. It also supports 3D file transfer between different programs (CoDesign). Com-

bined with the MCAD program, an actual product can be virtually demonstrated on the computer 

display. At the same time, the geometric collision can be detected by the program, and the design 

failure can be avoided at a very early stage. Figure 4-5 shows an example of CoDesign. The PCB 

was designed with Altium, and the transparent enclosure was designed with an MCAD program. 

The Enclosure was imported into Altium Designer, and the finished product could be demonstrated 

in Altium 3D view.    
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Figure 4-5 ECAD-MCAD Codesign in Altium designer (Altium, 2021) 

Interactive routing: The process of defining the path of connecting between nodes means routing. 

The rule of routing can be defined and adjusted in many ways. This makes the process of design 

flexible and, at the same time, has the accuracy and correct control of routing. (Altium, 2020) 

 

4.1.2 KiCad 

KiCad was initially released in 1992 and is a widely used free software for electrical design. Since 

the essential features compared to the Altium Designer are the same, it can be a suitable replace-

ment in many situations. (softwareradius, 2022) Figure 4-6 shows the project manager window in 

KiCad. It was the first view when the KiCad started.   

 

 

Figure 4-6 KiCad Project manager window 
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Some features of this software are listed below: 

Cross-platform and Free: KiCad can run on different operating systems, for instance Windows, 

macOS, and Linux. It is free to use, and anyone is allowed to download it from the internet and use 

it without pay.  

 

Easy-to-use and straightforward: Its user interface is intuitive and easy to understand. Free tu-

torials and documents can be found on its official website. This makes the learning curve much 

easier. 

 

Design rule checking: KiCad can automatically check the design failure with defined or custom 

rules, for example, short cut, conflicts, or unconnected pins. (Keeth, et al.) 

 

Library: KiCad has its library with pre-built components. It supports the import of external compo-

nents, and new library components can be created by requirement.  

 

3D viewer: 3D demonstration of the PCB board is supported by KiCad. And the 3D model can be 

exported as a file, which can be used in the MCAD program.   

 

4.1.3 Different Between Altium Designer and KiCad. 

Initial investment: Altium is not free software and offers various license types. Its official online 

store can be found at ttps://digitalsales.altium.com/. The time-based licenses start from 295 

Euro/month, and a perpetual license costs 9170 Euro. The KiCad is free software, and the initial 

investment much lower than Altium. 

 

Operating System support: Altium is only compatible with MS-Windows operating systems. 

KiCad could be supported by almost all popular operating systems (MS-Windows, macOS, Linux).  

 

Remote collaboration: Altium supports remote-working and cloud-based cooperation. Teamwork 

with Altium can have a good user experience since it is officially supported. KiCad does not support 

collaborative PCB design by itself, but there are third-party cloud services that can be integrated 
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with KiCad, for example, www.inventhub.io or Git (Abid, 2020). This makes the remote collaboration 

possible with KiCad. 

 

Project’s complexity: Altium Designer supports Hierarchical Schematic design. A big project can 

be separated into related small functions. It does also support the auto-routing feature. KiCad does 

not support these two valuable functions. Complex and big projects are because of these features 

getting more convenient with Altium Designer.  

 

MCAD support: booth Altium Designer and KiCad have 3D viewing capability, but Altium has little 

better support on MCAD, which combines ECAD with MCAD. But the MCAD future in Altium may 

not be good enough to replace a complete feature MCAD program.  

4.2 Fusion 360 & Autodesk Eagle  

Fusion 360 is a cloud based MCAD program used in design with the help of computer technology 

for mechanical equipment. Figure 4-7 presents the fusion 360 interfaces. Different tools, control 

panels, and 3D models are demonstrated from 1 to 9. 

 

 

Figure 4-7 Fusion 360 interface (Autodesk, 2022) 

Some features of this software are listed below: 

Cloud-based storage: Working with fusion 360 requires an internet connection. The files designed 

with Fusion 360 are saved remotely in the fusion 360 accounts. This makes cooperation over the 
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internet very easy, but it also supports offline working mode. Design can be done offline, and the 

files will be uploaded when the internet connection is available.  

 

Support different design methodologies: There are two types of design methodologies: bottom-

up and top-down. With the bottom-up method, each part of the system needs a detailed parameter 

before the system can be built. In the top-down methodology, the designer defines the relations 

between each component (such as the geometry of the parts, sketch) within an assembly. The 

CAD software organizes the connections between each element. Detailed parameters of the com-

ponents are evident after the system is completed. Both bottom-up and top-down methodology has 

their advantages and disadvantages. Fusion 360 provides different possibilities for the designer.   

 

Computer-aided manufacturing (CAM): CAM is supported by fusion 360. The design file can be 

directly printed with a 3D printer or generate CAM toolpaths for CNC machines. (Autodesk, 2022) 

 

ECAD & MCAD in one program: Fusion 360 is not only for mechanical designers. In 2020 the 

ECAD program Autodesk EAGLE was integrated into Fusion 360 (Autodesk, 2021).  

 

Cross-platform: Fusion 360 support different operating system and hardware platform. It can work 

in Microsoft® Windows®, Apple® macOS. 

 

Different price alternatives: Fusion 360 offers various price alternatives. The software is principal 

proprietary software. For non-commercial and personal use, this software is free for the first year 

and includes essential features. The limitation is the complexity of the project. The primary feature 

is more than enough for a simple project with fewer components. Commercial users can use this 

software and pay 60 euros each month or annually, approximately 500 euros.  

4.3 ECAD Library & Workflow 

The ECAD software helped us design electronic equipment. Different components are placed in 

the design, and they are carefully selected and connected according to the engineering require-

ments. With the ECAD program, all the design tasks are processed virtually on the computer. An 

electronic component was presented in the library differently. On the stage of schematic design, a 

component was presented as a schematic symbol. To design the PCB layout, the parameter of the 
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footprint was required. A 3D model of the component was used to demonstrate the actual compo-

nent on the computer monitor. All the three parts together presented an actual electrical component 

in the library. A collection of the symbols, footprints and 3D models formed an electronic compo-

nents library. Commonly used electronic components were included in most ECAD software. Figure 

4-8 and Figure 4-9 show the library in Altium Designer and KiCad.  

 

 

Figure 4-8 Components panel in Altium Designer 

 

Figure 4-9 Library panel in KiCad 

However, new devices and functions appear, and they may not be directly available in the software. 

The new components must be created in the library before using it in the design project.  
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Figure 4-10 PCB design workflow (Dalmaris, 2019) 

Figure 4-10 demonstrates a KiCad workflow in PCB design. The process in other ECAD programs 

is similar. It started with a schematic design (Eeschema). Symbols were placed from the schematic 

library on the schematic plan. After this, the route was designed, and it connected the pin of the 

symbols. The schematic plan with routing (netlist) was translated to the PCB design. In this step, 

the footprint library was used. The PCB layout was checked, failure could be detected and cor-

rected, and the particular files (Gerber files) were exported. The fabrication files were submitted to 

the PCB manufacturer, and the PCB could be fabricated.  
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5 Library and Application with PE Components 

Printed electronics is a new technology unlike the traditional electronic components, which were 

already included in most ECAD libraries. When an electronic project includes printed electronic 

components, the first step in the workflow is to create these components in the library. This chapter 

demonstrates the detailed process for creating the ECAD library's PE components.  

5.1 PE Resistor with KiCad 

5.1.1 New Project and Library Category 

In KiCad, all the schematic design and new library components are in one project. The first step in 

working with KiCad is to create a project. A new project is created by following the menu “File → 

New → Project…” (Figure 5-1).  

 

 

Figure 5-1 Creating a new KiCad Project 

Figure 5-2 shows the KiCad interface. Different quick links and tools are marked in the red rectan-

gle. These can be used for creating an electronic components library.  

 



  

40 

 

Figure 5-2 A new KiCad project 

Click the footprint editor symbol (Figure 5-3), and the footprint editor program (Figure 5-4) is 

started.  

 

Figure 5-3 Footprint editor symbol 

 

Figure 5-4 Footprint editor 

Since KiCad is developed for traditional electronic design, PE components can not be found in the 

library. A new library needs to be created. Right-click in the local libraries (or in the menu File), then 

click on “New library” (Figure 5-5), and a new category of the library is created.  
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Figure 5-5 Creating a new footprint library 

All the PE components were planned to be saved in the new category (Figure 5-6, “pas-

sive_PE_footprint”). 

 

Figure 5-6 A new library for PE components 

5.1.2 New Footprint 

Start making a new footprint by clicking the symbol “New footprint” (Figure 5-7).  
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Figure 5-7 New footprint symbol 

First, the “add pad” symbol ( ) in the footprint editor toolbox is chosen. Then two pads are created 

in the footprint editor. Depending on the component, which will be mounted on this pad, the pad’s 

dimensions can be different. In this case, the pad has 3 mm in width and 2.5 mm high. Pad prop-

erties could be activated by double-clicking on the pad. Figure 5-8 shows the properties of the pad. 

 

Figure 5-8 Pad properties 

Figure 5-9 demonstrates a footprint for a PE resistor, which can be used for mounting the resistor 

mentioned in reference (Correia, et al., 2018). Its 3D view is shown in Figure 5-10. 
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Figure 5-9 Footprints of a PE resistor 

 

Figure 5-10 Footprints of a PE resistor in 3D view 

5.1.3 3D Modelling PE Resistor 

As part of the KiCad function, a 3D Model of electronic components can be virtually present. The 

3D view in Figure 5-10 shows only the footprint without a related resistor. Unfortunately, KiCad 

does not include a 3D modeling tool for electronic components. Instead, a 3D Model of an electronic 

component can be imported into KiCad. To create a 3D Model for PE components, another CAD 

program (Fusion 360) was applied. Figure 5-11 shows the sketch tool in Fusion 360. A sketch with 

related dimensions was drawn. The Centre of Figure 5-11 offers the sizes of the PE resistor.  
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Figure 5-11 Sketch tools and PE resistor dimensions 

Sketch tools defined length and width, and the thickness of the printed layer was generated with 

the tool Extrude (Figure 5-12). This PE resistor had a thickness of 1.6 µm (Correia, et al., 2018). 

Accordingly, the parameter for extruding was set at 0.0016 mm. A 3D Model for this electronic 

component was created.  

 

 

Figure 5-12 Extrude in Fusion 360 
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This 3D model was exported in a format that KiCad can use. In Fusion 360, select “File → Export”, 

and an export dialog was opened. They then chose STEP as a file format and exported the 3D 

model. Then the work in Fusion 360 is completed. 

 

 

Figure 5-13 Export 3D model 

The STEP file has been imported into the KiCad at this step. In footprint editor, click on the symbol 

“footprint properties” (Figure 5-14 first step, or from the menu Edit → Footprint properties). Then 

open the STEP file, which is created by Fusion 360. Following the second to fifth steps in Figure 

5-14, the 3D model is imported in KiCad. 
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Figure 5-14 Import 3D Model in KiCad 

The 3D model may not be perfectly positioned on the footprint. The component’s position (Figure 

5-15) has to be changed until it is correctly located on the footprint. At the same time, a preview is 

presented.  

 

 

Figure 5-15 3D Model preview 
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5.1.4 Connecting Electronic Symbol with a Footprint 

The electronic symbols are a part of the library. They are necessary for making electronic sche-

matics. The symbol editor can be found in the “Tools → Edit Schematic Symbols.” The previous 

literature research on PE shows that the same symbols were used in traditional electronics and PE 

(Correia, et al., 2018) (Ostfeld, et al., 2015) (Menicanin, et al., 2015) (Menicanin, et al., 2013). Since 

passive PE and traditional electronic components have similar functions and symbols already in-

cluded in the KiCad Symbol libraries, creating new symbols for passive PE components is unnec-

essary. However, the KiCad local libraries are not automatically connected with the newly created 

PE footprint. A new footprint value must be assigned for the symbols during the design process. 

Figure 5-16 shows the procedure for connecting electronic symbols with customized footprints. 

Double click the symbol in the schematic layout editor (Figure 5-16 number 1), and the symbol 

properties dialog opens. Then open the footprint library browser by clicking the red cycle in Figure 

5-16, number 2. Finally, select the corresponding footprint in steps 3 and 4 (Figure 5-16). 

 

 

Figure 5-16 Symbol properties and footprint 

5.2 Capacitor Library in Altium Designer 

Making a new library component in KiCad for PE capacitor is similar to making a resistor component 

described in chapter 5.1.  Compared to this free software, Altium Designer is famous in industrial 

applications. This chapter descripts the process for creating a printed capacitor library in Altium 

Designer. It has similar library files (Figure 5-17) as in KiCad. A schematic library is used for creat-

ing schematic symbols, which were the primary elements in the electronic schematic plan. A foot-

print is completed in the PCB library, and a 3D Model is a part of the footprint. (Altium, 2021) 
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Figure 5-17 Crating the new Altium Designer library 

5.2.1 Schematic Symbols 

New schematic symbols need to be created inside a schematic library, a container for the sche-

matic symbols. A new empty library was created following the menu “File → New → Library → 

schematic Library”. The library has a file name with the suffix “.SchLib”. Double click and open this 

library. Switch the interface between “projects” and “SCH Library”. Figure 5-18 shows the different 

views between “projects” and “SCH Library”. On the left side (Figure 5-18), a new schematic symbol 

can be created in the “SCH Library”.  

 

  

Figure 5-18 Libraries for schematic symbols 

 

Follow the menu “Tools → New Component” and create a new component. A library component 

is made without a symbol. Different tools could be used for drawing the symbols. Figure 5-19 pre-

sents the tools. 
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Figure 5-19 Tools for drawing the symbols 

Figure 5-20 shows a capacitor symbol, which was created with the tool “Place → Line” (blue) and 

“Place → Pin” (black). 

 

 

Figure 5-20 Capacitor symbol 

5.2.2 Footprint 

The footprint was included in the “PCB Library” because this “PCB Library” needs to be created 

first. Figure 5-21 makes a PCB Library (File → New → Library → PCB Library). The library has a 

file name with the suffix “.PcbLib”.  
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Figure 5-21 Creating a PCB Library 

Open the newly created PCB Library and create a new footprint (Tools → New Blank Footprint). 

Two mounting pads were drawn. These will be the mounting place for the two electrodes of the 

printed capacitor. The tool was found in the menu “Place → Pad”. The properties of the two elec-

trodes were adapted according to the geometry of the printed capacitor. Electrode 1 was placed on 

the origin of the coordinate. Both x and y are zero. Electrode 2 was placed at the position x = 21.5 

mm (46.457 mil), y = 0 mm. Electrodes 1 and 2 had the same width (x = 1 mm) and length (y = 

19.7 mm). They were placed on the “Top Layer”. The red frame in Figure 5-22 shows the properties 

of electrode 1. 

 

  

Figure 5-22 Pad properties  
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In the next step 3D model of the printed capacitor was imported. Select “3D Body” from the menu 

“Place” (Figure 5-23). Then select the 3D model (chapiter 5.2.3). The capacitor was placed on the 

“Pad”.  

 

 

Figure 5-23 3D Body for footprint 

Figure 5-24 shows the 2D and 3D footprint layouts. In the 3D layout, the capacitor was presented 

from the back view. The grey color is the printed capacitor, and the golden area contacts the two 

electrodes of the capacitor.  

  

Figure 5-24 PE Capacitor footprint 2D (left) and 3D (right) layout 

5.2.3 Creating a 3D Body for PE Capacitor 

The 3D model of the printed capacitor was created with Fusion 360. The same technique was 

implemented, which was described in chapter 5.1.3. The two electrodes had a width of 1.00 mm 
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and 19.75 height. The finger of the capacitor had the dimension 20.25 mm X 0.75 mm, and the 

space (not printed area) between each finger was 0.25 mm. It had 20 interdigital pairs. The size of 

the capacitor is shown in Figure 5-25 left. On the right (Figure 5-25), the 3D model was presented.  

  

Figure 5-25 Dimensions of PE capacitor (left) and 3D Model (right) 

5.2.4 Footprint for Schematic Symbol 

Footprint and schematic symbols were created in the previous chapters. The footprint can be as-

signed to the corresponding schematic symbol. The process has different steps. They were pre-

sented with a montaged graphic in Figure 5-26. 

 

 

Figure 5-26 Footprints for schematic symbol 
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In the schematic library, select the component capacitor. Then open the symbol’s properties (Figure 

5-26 step 1). Then find the parameter Footprints, selecting the button “Add…” (Figure 5-26 second 

step), then select Footprint (Figure 5-26 third step). A new dialog is opened. Browse (Figure 5-26 

fourth step) and select (Figure 5-26 fifth step) the PCB library, which contains the footprint of the 

capacitor. Select the component (Figure 5-26 sixth step), then click OK. The footprint is assigned 

to the symbol. 

5.3 Application of PE library  

5.3.1 Project Structure and New Project 

Chapters 5.1 and 5.2 demonstrated the workflow for creating resistor and capacitor library compo-

nents in KiCad and Altium Designer. The workflow for creating an electronic components library is 

similar in both software. A library component includes a schematic symbol used for the schematic 

plan. A footprint describes the dimension of the components and is used in planning an actual 

circuit board—a 3D model, which demonstrates the actual product with the monitor.  

 

This chapter created a simple RLC circuit with Altium Designer including customized library ele-

ments. A new project was completed in Altium Designer, and this file has the file name with the 

suffix “.PrjPcb”. Four files were necessary to create a printed circuit, and they were part of the 

project. A schematic document includes the schematic plan. A schematic library consists of all 

electronic symbols. A PCB document represents the layout of the printed circuit. A PCB library 

consists of each electronic component's footprint and 3D model. The red frames in Figure 5-27 

show the five necessary files for creating a printed circuit.  
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Figure 5-27 New Altium Designer Project 

5.3.2 Import Existing Libraries  

Since the schematic Library (schematic_PESymbol.SchLib) and PCB Library (PE_fotprint.PcbLib) 

were already created, they will be used in the new project. Follow the menu “File → Open” and 

open the libraries highlighted as in Figure 5-28.  

 

 

Figure 5-28 Libraries with PE components 

The opened libraries were still outside of the project. Figure 5-29 left shows the files 

“PE_foofprint.PcbLib” and “schematic_PESzmbol.SchLib” are under the “Free Documents”. Left-

click and pull the libraries into the current project “RLC_circuit.PrjPcb” (Figure 5-29 right). The li-

braries are imported successfully. 
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Figure 5-29 Libraries outside (left) and inside (right) the Project 

5.3.3 Creating Schematic Plan  

A schematic document (File → new → Schematic) and a PCB document (File → new → Sche-

matic) were created. The structure of the project looks as in Figure 5-30. Under the project (file 

“RLC_circuit.PrjPcb”), there were four files “RLC.SchDoc”, “RLC.PcbDoc”, and “PE_foot-

print.PcbLib” and “schematic_PESymol.SchLib”, they represented schematic document, PCB doc-

ument, footprint library, and symbol library.  

 

 

Figure 5-30 New schematic and PCB documents 

Double click and open the schematic document “RLC.SchDoc” in Altium Designer. Place the resis-

tor, inductor, capacitor, and a 2-pin header symbol in the document with the tool “place part” (or in 

the menu “Place → Part”). They then connect all the components by placing the wire (“Place → 

Wire”). The circuit shows in Figure 5-31, and the symbols are not annotated.   
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Figure 5-31 RLC circuit before annotation 

The “annotation” (in the menu “Tool → Annotation → Annotation Schematics…”) was implemented 

(Figure 5-32). Then the number of the symbols was updated. The final schematic plan is shown in 

Figure 5-33. 

 

Figure 5-32 Annotate schematics 

 

Figure 5-33 RLC circuit schematic plan 
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5.3.4 Layout of Printed Circuit  

Before the printed layout was created, all the design information in the schematic document needed 

to be translated to the PCB document. A process “Update PCB Document” was executed from the 

menu “Design → Update PCB document”, then the changes were validated and executed (Figure 

5-34). After this process, the necessary information was transferred from the schematic plan to the 

PCB layout document (Figure 5-35).  

 

Figure 5-34 Update PCB Document 

Figure 5-35 shows the printed circuit with footprint and 3D components. The automatic execution 

in Figure 5-34 did not wire the components together, and its position was not optimized.  
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Figure 5-35 2D (left) and 3D(right) layout from schematic plan 

The position of the electronic components was changed by moving them with the mouse. In this 

way, the wire could be placed without overlap. With the help of the tool “interactive routing” (or in 

the menu “Place → Track”), the resistor, capacitor, and inductor were connected. The final result 

is presented in Figure 5-36.  

 

  

Figure 5-36 Render image of printed RLC circuit on transparent film front (left) and back view 
(right) 

Now a printed RLC circuit with customized library components has been created.  

 

This chapter demonstrated the essential elements (schematic symbols, footprints, and 3D bodies) 

in creating printed passive components. Two ECAD programs and an MCAD program were used 

as practical examples. Different library elements (resistor, capacitor, and inductor) were created, 

and a standard procedure for making a PE library was demonstrated in detailed steps. Figure 5-37 

shows the relationship between each element in a CAD Library. 
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Figure 5-37 Elements of CAD Library and applied software tools 

Schematic symbols

• KiCad or

• Altium Designer

Footprint

• KiCad or

• Altium Designer

3D Body

• Fusion 360

CAD Library 

• KiCad or

• Altium Designer
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6 Discussion and Conclusion  

This work presented a summary of passive printed electronic components, and the difference be-

tween traditional passive components and printed passive components was discussed. The fabri-

cation materials, methods, and processes for the printed passive components, especially resistor, 

capacitor, and inductor, were researched. A way of creating the library for different passive com-

ponents was demonstrated. In the end, a simple RLC circuit was created with a new passive PE 

components library.  

 

The CAD software is a big family. Choosing the correct CAD tool for the PE application was a 

significant change. The learning curve on different CAD software was influenced by personal 

knowledge background. Three CAD software were introduced in this works to create a PE library. 

Two of them (Altium designer and KiCad) are especially designed for ECAD applications. One 

software (Fusion 360) was initially intended for the MCAD application, but now it also includes the 

ECAD module. Many other CAD programs may also be suitable for creating the passive PE library 

components. Because of budget and time limitations, creating the PE library for all the software 

was not the purpose of this work. However, Altium designer and KiCad are excellent and typically 

represent the other ECAD software. Both are widely used programs. Altium Designer represents 

industrial standard and professional quality whereas KiCad is about open source, good quality and 

functionality.    

 

This work shows a potential working process for creating a passive PE components library. By the 

time this work was completed, a standard library for PE components could not be found yet. Printed 

electronics is a fast-growing industry in the current and foreseeable future. Using a standard library 

can promote development and cooperation in this area. Creating a PE library with widely used 

components and collecting the components in a standard library can be valuable works for the 

future.  
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8 Appendices  
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PRINTED PASSIVE COMPONENTS LIBRARY  APPENDIX 1 

This appendix includes data for Altium Designer, KiCad, and STEP files of 3D models created in 

this work.   


